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The standard warranty contained in the seller’s standard conditions of sale, as set forth 
in Price Sheets 150 and 181, applies to IntelliNode Interface Modules, except that the first 
and second paragraphs of said warranty are replaced by the following:

(1) General: The seller warrants to the immediate purchaser or end user for a period of 
10 years from the date of shipment that the equipment delivered will be of the kind 
and quality specified in the contract description and will be free of defects of work-
manship and material. Should any failure to conform to this warranty appear under 
proper and normal use within 10 years after the date of shipment the seller agrees, 
upon prompt notification thereof and confirmation that the equipment has been 
stored, installed, operated, and maintained in accordance with recommendations 

Special Warranty 
Provisions

Qualified Persons
 WARNING

Only qualified persons who are knowledgeable in the installation, operation, and 
maintenance of overhead and underground electric distribution equipment, along 
with all associated hazards, may install, operate, and maintain the equipment covered 
by this publication . A qualified person is someone who is trained and competent in:

• The skills and techniques necessary to distinguish exposed live parts from nonlive 
parts of electrical equipment

• The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

• The proper use of special precautionary techniques, personal protective equipment, 
insulated and shielding materials, and insulated tools for working on or near exposed 
energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not intended 
to be a substitute for adequate training and experience in safety procedures for this 
type of equipment .

Read this Instruction 
Sheet

NOTICE

Thoroughly and carefully read this instruction sheet and all materials included in the 
product’s instruction handbook before installing or operating the IntelliNode Interface 
Module . Become familiar with the Safety Information and Safety Precautions on 
pages 4 and 5 . The latest version of this publication is available online in PDF format 
at sandc.com/en/support/product-literature/ .

Retain this Instruction 
Sheet

This instruction sheet is a permanent part of the IntelliNode Interface Module. Designate 
a location where users can easily retrieve and refer to this publication.

Proper Application
 WARNING

The equipment in this publication is only intended for a specific application . The 
application must be within the ratings furnished for the equipment . Ratings for the 
IntelliNode Interface Module are listed in the ratings table in Specification Bulletin 
1043-31 .
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The standard warranty contained in the seller’s standard conditions of sale, as set forth 
in Price Sheets 150 and 181, is contingent upon the installation, configuration, and use 
of the control or software in accordance with S&C’s applicable instruction sheets. This 
warranty does not apply to major components not of S&C manufacture, such as batter-
ies, communication devices, and remote terminal units. However, S&C will assign to the 
immediate purchaser or end user all manufacturers’ warranties that apply to such major 
components.

Warranty of equipment/services packages is contingent upon receipt of adequate 
information on the user’s distribution system, sufficiently detailed to prepare a 
technical analysis. The seller is not liable if an act of nature or parties beyond 
S&C’s control negatively impact performance of equipment/services packages;  
for example, new construction which impedes radio communication, or changes to the 
distribution system that impact protection systems, available fault currents, or system 
loading characteristics.

Warranty 
Qualifications

of the seller and standard industry practice, to correct the nonconformity either by 
repairing any damaged or defective parts of the equipment or (at the seller’s option) 
by shipment of necessary replacement parts. The seller’s warranty does not apply 
to any equipment that has been disassembled, repaired, or altered by anyone other 
than the seller. This limited warranty is granted only to the immediate purchaser 
or, if the equipment is purchased by a third party for installation in third-party 
equipment, the end user of the equipment. The seller’s duty to perform under any 
warranty may be delayed, at the seller’s sole option, until the seller has been paid in 
full for all goods purchased by the immediate purchaser. No such delay shall extend 
the warranty period. 

The seller further warrants to the immediate purchaser or end user that for a 
period of two years from the date of shipment the software will perform substan-
tially in accordance with the then-current release of specifications if properly 
used in accordance with the procedures described in seller’s instructions. The 
seller’s liability regarding any of the software is expressly limited to exercising its  
reasonable efforts in supplying or replacing any media found to 
be physically defective or in correcting defects in the software during the  
warranty period. The seller does not warrant the use of the software will be unin-
terrupted or error-free.

For equipment/services packages, the seller warrants, for a period of one year 
after commissioning, that the IntelliNode Interface Modules will provide automatic 
fault isolation and system reconfiguration per agreed upon service levels. The 
remedy shall be additional system analysis and reconfiguration of IntelliTeam SG 
system until the desired result is achieved.
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Several types of safety-alert messages may appear throughout this instruction sheet and 
on labels attached to the IntelliNode Interface Module. Become familiar with these types 
of messages and the importance of these various signal words:

 DANGER
“DANGER” identifies the most serious and immediate hazards that will result in 
serious personal injury or death if instructions, including recommended precautions, 
are not followed .

  WARNING
“WARNING” identifies hazards or unsafe practices that can result in serious personal 
injury or death if instructions, including recommended precautions, are not followed .

  CAUTION
“CAUTION” identifies hazards or unsafe practices that can result in minor personal 
injury if instructions, including recommended precautions, are not followed .

NOTICE

“NOTICE” identifies important procedures or requirements that can result in product 
or property damage if instructions are not followed .

If any portion of this instruction sheet is not understood and assistance is required, 
contact the nearest S&C Sales Office or S&C Authorized Distributor. Their telephone 
numbers are listed on S&C’s website sandc.com, or call the S&C Global Support and 
Monitoring Center at 1-888-762-1100.

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing or operating the IntelliNode Interface 
Module .

If additional copies of this instruction sheet are required, contact the nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting the nearest S&C Sales Office, 
S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Understanding Safety-
Alert Messages

Following Safety 
Instructions

Replacement 
Instructions and 
Labels
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  DANGER

The IntelliNode Interface Module line voltage input range is 93 to 276 Vac. 
Failure to observe the precautions below will result in serious personal injury 
or death.

Some of these precautions may differ from your company’s operating procedures 
and rules . Where a discrepancy exists, follow your company’s operating procedures 
and rules .

1 . Qualified Persons. Access to the IntelliNode  
Interface Module must be restricted only to qualified 
persons . See the “Qualified Persons” section on 
page 2 .

2 . Safety Procedures. Always follow safe operating 
procedures and rules . Always maintain proper 
clearance from energized components .

3 . Personal Protective Equipment. Always use 
suitable protective equipment, such as rubber 
gloves, rubber mats, hard hats, safety glasses, arc-
flash clothing, and fall protection, in accordance with 
safe operating procedures and rules .

4 . Safety Labels and Tags. Do not remove or obscure 
any of the “DANGER,” “WARNING,” “CAUTION,” or 
“NOTICE” labels and tags . Remove tags ONLY if 
instructed to do so .

5 . Maintaining Proper Clearance. Always maintain 
proper clearance from energized components .
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These instructions were prepared for use with IntelliNode software installer versions 
ITNInstaller-7.6.x and later. References in this manual to the IntelliTeam SG Automatic 
Restoration System apply to IntelliTeam SG software revision 7.6.x, as indicated in 
Instruction Sheet 1044-570, “S&C IntelliTeam® Designer: User’s Guide.”

The revision number can be found on the Setup>General>Revisions screen. For 
questions regarding the applicability of information in this chapter to previous software 
releases or future versions later than 7.6.x, contact S&C Electric Company.

     WARNING
Serious risk of personal injury or death may result from contact with electric 
distribution equipment when electrical isolation and grounding procedures 
are not followed. The equipment described in this document must be operated 
and maintained by qualified persons who are thoroughly trained and understand 
any hazards that may be involved . This document is written only for such qualified 
persons and is not a substitute for adequate training and experience in safety 
procedures for accessing high-voltage equipment .

     WARNING
These instructions do NOT replace the need for utility operation standards . Any 
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct 
procedures to follow .

The S&C IntelliNode Interface Module is connected to switchgear operating at 
primary voltage levels . High voltage may be present in the wiring to the switch 
control or the switch control itself during certain failures of the switchgear wiring 
or grounding system, or because of a failure of the switch itself . For this reason, 
access to the switch control should be treated with the same safety precautions that 
would be applied when accessing other high-voltage lines and equipment . Follow all 
locally approved safety procedures when working on or around this switch control .

Before attempting to access an existing switch installation, check carefully for 
visible or audible signs of electrical or physical malfunction (do this before touching 
or operating the switch control or any other part of the installation) . These warning 
signs include such things as smoke, fire, open fuses, crackling noises, loud buzzing, 
etc . If a malfunction is suspected, treat all components of the installation, including 
the switch control and associated mounting hardware, as though they were elevated 
to primary (high) voltage .

Whenever manually reconfiguring the circuit (for example, during repairs), follow 
your company’s operating procedures to disable automatic operation of the 
IntelliTeam  SG Automatic Restoration System . This prevents any unexpected 
operation of a team member . 

The IntelliTeam SG Automatic Restoration System can be disabled by selecting the  
Prohibit Restoration state for any member of a team being disabled .

Applicable Software
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Local Communication Access Port—This port connect the computer to  
the IntelliNode module and uses IntelliLink software to view data, change setpoints, 
download logged data, and update IntelliNode module software.

Power Input Terminals—The panel-mounted IntelliNode module requires 12 Vdc. The 
rack-mounted IntelliNode module can be ordered for a specific power requirement of 
12 Vdc, 24 Vdc, 48 Vdc, 125 Vdc, 120 Vac, or 240 Vac.

IED Communication Port—This port connects to the external device and communicates 
using DNP 3.0 protocol. The IntelliNode module is configurable to use the DNP points 
mapped in the host device to satisfy the data requirements of the IntelliTeam SG system.

Two Radio Communication Ports—These ports are used for connection to an S&C 
SpeedNet® Radio, a fiber-optic transceiver, or other SCADA radio. The DNP points list 
is configurable.

IntelliNode Faceplate This section describes various IntelliNode module displays and controls. The “Operational  
Overview” section on page 12 explains how these components work with the external 
device to monitor the distribution feeder and manage switch operation.

IntelliNode module controls are shown in Figures 1 and 2.

Figure 1. The panel-mounted IntelliNode module faceplate.

Figure 2. The rack-mounted IntelliNode module faceplate.
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The faceplate includes these LEDs:

Prohibit Restoration
These LEDs indicate when the Prohibit Restoration mode is in the Enabled state.

Extended Volt-Loss Trip
This LED is on when a trip occurs because of the IntelliNode module’s extended voltage-
loss logic.

System OK If Blinking
This LED blinks once per second when the IntelliNode module software is  
running normally.

Remote Communication RCV/XMT Indicator
These LEDs blink when the switch control sends or receives signals through remote 
communication equipment installed in the control enclosure. There are separate indi-
cators for Port A and Port B. The RCV indicator blinks when the switch control detects 
an incoming character. The XMT indicator blinks when the switch control sends one or 
more characters. Comm Ports A, B, and C are indicated.

Activity will be seen on these LEDs only if remote communications equipment is 
installed, properly connected, and receiving power. The XMT LED blinks any time a 
transmission is attempted, regardless of whether the communications equipment is 
properly installed.

The faceplate includes the following switches:

Prohibit Restoration
Press the CHANGE button to enable or disable the Prohibit Restoration mode.

Note: When selecting the Prohibit Restoration mode, the IntelliTeam SG system 
operation in all teams tied to this control is disabled.

Lamp Test switch
Press this switch to illuminate all LEDs and test that they operate.

LCD Display Navigation switches
Use this switch group to scroll each LCD screen into view and enter commands from the 
faceplate. The ESC button returns the LCD screen to the main screen, which displays 
team status information.

The faceplate LCD screen quickly accesses key information while the user is at the site. 
The LCD screen shows five categories of information. See Table 1 on page 9. The top 
line of the display always begins with the category number.

• Team Status Info—This display includes the team ID and the Ready/Fault/Alarm 
status for each team where this control is a member. “R” indicates the team is in the 
Ready mode to take action (even if a transfer event has already taken place) and that 
there are no errors, faults, or team communication problems present. “F” indicates 
this team is isolating a faulted line segment. “A” indicates an Alarm state is active. 
An active switch error and the Prohibit Restoration status are also indicated. Real-
Time Load and Capacity are displayed for each team. Team-status information is also 
reported on the IntelliTeam SG>Team Summary screen.)

• Changeable Parameters

• External Device Information 

• Communications Information

• Miscellaneous Information—The software version, firmware identification, and 
physical location of the control are indicated. These values are also reported on the 
Setup>General screen.

Faceplate LEDs

Faceplate Switches

Faceplate LCD
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Category Field Description

1 . Teams 1 . Team Status Summary
(indicated for each team by 
team number)

R = Ready status
A = Alarm status
F = Faulted status
– = Team not configured status

1 . Team Sw . Errors: When PRESENT, press the ENTER  
button to clear the error indication

1 . Team Prohibit Restore ON or OFF, use the CHANGE Prohibit Restoration 
button, on the faceplate, to change the status

1 . Team 1 <Name> Load and Capacity
(Amps x 1 .0)

  (Note: The team <Name> is entered
  on the IntelliTeam SG>Team X screen .)

1 . Team 2 <Name>

1 . Team 3 <Name>

1 . Team 4 <Name>

1 . Team 5 <Name>

1 . Team 6 <Name>

1 . Team 7 <Name>

1 . Team 8 <Name>

2 . Changeable
    Parameters

2 . Compact Flash ON or OFF, press the ENTER button to change 
the state
(Turn off before removing the CF card .)

2 . Volt Loss Sectionalize ON or OFF, press the ENTER button to change 
the state

3 . External
    Device

3 . Switch Status CLOSED, OPEN, BAD, or ERROR

3 . Supervisory Mode LOCAL, REMOTE, or N/A

3 . Trouble Status NORMAL, PRESENT, or N/A

3 . Fault Status NORMAL or DETECT

3 . Voltage Status NORMAL or ACTIVE

3 . Freq . Trip Status NORMAL, ACTIVE, or N/A

3 . Active Profile NORMAL, ALTERNATE, or N/A

3 . Hot Line Tag NORMAL, ACTIVE, or N/A

3 . Ground Trip UNBLOCKED, BLOCKED, or N/A

3 . Reclosing UNBLOCKED, BLOCKED, or N/A

Table 1. IntelliNode LCD Data
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Category Field Description

4 . Communica-
    tions

4 . Local Address DNP/RTU network address

4 . Master Address Master Station RTU address

4 . Master Port DNP frames destined for the Master Station 
are sent to this port: A, B, C, D, or N/A . (D is 
the port on the faceplate)

4 . Master IP Address IP address used to route DNP frames to 
Master Station over a UDP connection

4 . Maint . Master Secondary master address that will not receive 
unsolicited messages

4 . Unsolicited:ENABLED
    or DISABLED

From Setup>Communications>DNP screen

4 . Port A \Baud +
    Protocol: DNP or ICP

From Setup>Communications>Serial Ports 
screen

4 . Port B \Baud +
    Protocol: DNP or ICP

From Setup>Communications>Serial Ports 
screen

4 . Port C \Baud +
    Protocol: DNP or ICP

From Setup>Communications>Serial Ports 
screen

4 . Port D \Baud +
    Protocol: DNP or ICP

From Setup>Communications>Serial Ports 
screen

4 . Native IP:
    XXX .XXX .XXX .XXX

4 . Add-on IP:
    XXX .XXX .XXX .XXX

5 . Miscellaneous 5 . Ver: XXX .XXX .XXX .XXX
Product: XXXXXXXX

Software version number;
software product identification

5 . Location Info 1:
XXXXXXXXXXXXXXXX

48-letter physical location of control
entered on Setup>General>Site Related 
screen

5 . Location Info 2:
XXXXXXXXXXXXXXXX

Continuation of screen above

5 . App . Code Info:
XXXX .XXXX .XXXX .XXXX

Used by S&C to track exact identity and 
ensure application integrity

5 . EOS Info:
XXX .XXX .XXX .XXX

Operating system version installed
in the control

Table 1. IntelliNode LCD Data—Continued

10  S&C Instruction Sheet 1043-541

Operation



The control firmware is factory installed and manages control operation. It continually  
monitors:

• SCADA commands

• Faceplate switch commands

• Internal clock and calendar

• Software setpoint values

• Other setpoints and data values as needed

Based on this information, the control software decides how to respond to a command 
from the faceplate or SCADA master station, and other conditions.

The control software, setpoint values, and historical data are stored in non- 
volatile flash memory that can survive power interruptions, including complete failure 
of the switch control battery system.

The IntelliLink Setup Software is downloaded from the S&C Automation Customer  
Support Portal and runs on PC computers. This software allows users to communicate 
with the control while at the switch-control site or remotely over a communication network 
that supports DNP communication. IntelliLink software can:

• Configure installation-dependent operating parameters (setpoints), such as the  
network address, automatic-operation features, etc.

• Monitor real-time data, such as the present line voltage and current

• Examine the performance and operating history of an installed switch control

• Transfer all configuration, operating, and historical data from the switch control to a 
report file on a computer

• Download new control software into the switch control

• Troubleshoot switch control installation problems

NOTICE
With software later than version 7 .3 .100, the default passwords for all user accounts, 
including the Admin account, must be changed before the IntelliLink software can 
connect to and configure a control . See Instruction Sheet 1043-531, “IntelliNode™ 
Interface Module: Setup,” for more information .

The S&C IntelliTeam SG system uses the DNP 3.0 protocol for team communication. 
When the SCADA system uses DNP users can remotely monitor, control, and change  
setpoints for all IntelliTeam SG switch controls. The DNP points are configurable to match 
the existing SCADA configuration.

The communication hardware (radio, modem, etc.) is mounted inside the switch  
control enclosure on the universal communication mounting plate on the back of the 
faceplate. This provides better reliability for the entire installation.

See Instruction Sheet 1043-561, “IntelliNode Interface Module: DNP Points List and 
Implementation,” and the communication equipment documentation for more informa-
tion. If you have any questions, contact S&C Electric Company.

IntelliNode Software

IntelliLink Software

SCADA 
Communications 
Equipment
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The IntelliNode module and host control device work together to detect and respond to 
overcurrent fault events and voltage outages.

When a circuit event occurs, the response taken by automated equipment in the  
IntelliTeam SG system proceeds in two steps: 

• Isolation of the normal source from the faulted circuit section is the first step. 

• Restoration of unfaulted circuit sections is the second step. 

The IntelliTeam SG Automatic Restoration System provides the restoration function 
after the successful isolation of the normal source by the IntelliRupter fault interrupter, 
breaker, recloser, or  sectionalizing switch.

The IntelliNode module does not interfere with the normal fault-isolation function-
ality of its host breaker/recloser device. The IntelliNode module only monitors the 
host device for changes in status so it can begin to take action should the host device 
indicate it has interrupted a fault and locked out. Monitoring is performed over a DNP 
communications link at a preconfigured polling interval, normally one second. The data 
received from the host device includes switch status, lockout status, overcurrent status, 
voltage status, error status, and other information so the IntelliTeam SG system has 
adequate information to perform its restoration function.

The IntelliNode module takes control of the host device when the host device trips 
open and is in the Lockout state or a source-side device has tripped open and locked 
out. When the host device is not open (because of a source side fault) but the IntelliTeam 
system determines that the source device for this team is open and locked out, the  
IntelliNode module will command the host device to open, and the reconfiguration process 
can continue. This is the only situation where the IntelliNode module will open the host 
device for the purpose of isolation.

By acting as a typical team member, the IntelliNode module may close the host breaker/
recloser device at the appropriate time during the IntelliTeam system reconfiguration 
process. The IntelliNode module and the IntelliTeam system may use some features of 
the host breaker/recloser device if allowed to by the configuration. 

For example, when closing the host breaker/recloser into a dead section of the circuit, 
the IntelliNode module may disable the reclosing feature of the breaker/recloser. When the 
breaker/recloser remains in the closed position for the configured time period, indicating 
the reenergized circuit section is unfaulted, the IntelliNode module will then re-enable 
the reclosing feature.

Operational Overview
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Automatic Load 
Transfer

The IntelliTeam SG system defines a team as two or more switch controls that protect a 
given line segment by transferring load to an alternate source. The switch control may 
be a member of one or more teams.

After completing the sectionalizing and/or phase-loss logic, the switch control can 
reclose the switch to transfer load to an adjacent distribution circuit or to restore 
service to load on the source side of the fault. The switch control uses information it  
receives from other team members to do this.

Team members use an independent software agent—the coach—to distribute data 
and coordinate operation. The coach visits each team member within a prescribed  
time period, carrying with it an ID number and incrementing visit counter. When the coach  
arrives at a team member that has already seen that ID and visit counter, the coach  
assumes it is a duplicate and dies.

The team member generates a new coach when the coach has not visited that team 
member within a prescribed time period. The new coach will have an ID one number 
higher than the last visiting coach and a visit counter reset to zero. The new coach  
determines the state of the team line segment and takes any necessary action. When an 
arriving coach finds that a new coach with a higher ID has visited, the arriving coach 
with the lower ID dies.

Any team member that witnesses an event tells all other team members and the coach 
about the event. The transmission includes a sequence number, the nature of the event, 
and which team member made the report. All members continually monitor for this  
report.

When the report requires local team restoration, the coach visits the other normally 
closed team members to verify they are now open and then follows the alternate source 
sequence list, visiting team members that could become an alternate source.

When the report requires service restoration for an adjacent team, the coach  
immediately moves to the team member that is also a member of the team with the  
outage.

Load averaging stops when an event begins so the load value before the event will be 
used for reconfiguration negotiations.

Loading Restrictions
As the default, a team decides whether to restore a line segment based only on the  
available capacity of the feeder. It is updated as the reconfiguration progresses and with 
any restrictions placed on the line segment caused by wire size, switch capacity, or other 
limiting factor.

This method does not prevent circuit overloading when non-continuous line segments  
(a bifurcated circuit) assume that loading information is correct and both close  
simultaneously to restore independent loads.

When a line segment cannot handle any overloading, set the Contract Required  
mode (on the Setup>Restoration>IntelliTeam SG> Team X screen) to “Yes” for all 
teams. When team members encounter a line segment in a restoration path that  
requires a contract, they communicate with all subsequent line segments in the direction 
of the alternate source to ensure the alternate source will not be overloaded. This slows 
the reconfiguration process.
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Contracts

The number of line segments a team can pick up is restricted by using the Line  
Segment Limit setpoint on the Setup>Restoration>IntelliTeam SG>Team X screen.  
For example, the Add 1 value inhibits any other line segments from being restored through 
a member after it restores its first line segment. When set to the N/A value, the team can 
pick up as many line segments as capacity will allow. 

The line segment limit may be configured in any or all teams, but it is a 
global value for all members in that team. The limit is continuously propa-
gated outward from the source segment as the coach travels from team member 
to tea m member. A s the l imit propagates outwa rd, l imits with a lower  
configured count take precedence and are then propagated further.

When the coach arrives at the team member for the switch it would like to close, 
it looks for the coach from the adjacent team. If it’s not already there, the first coach 
calls, and the second coach will move to the shared team member. Both coaches decide  
whether to close the switch based on available capacity, contracts for resources, and other  
restrictions. 

As switches close, the IntelliTeam SG system updates available capacity on the 
feeders used to restore service. When a transfer with a known load value occurs, it  
resets the loading data to reflect the new value. This updates information more quickly 
than the Two-Minute Load Averaging feature.

As load is restored, some team members may want to begin the Return to Normal  
process for their team(s). But the Return to Normal process is blocked by the Two-Coach 
Rule. When a coach knows its team is not being fed from its normal source, it will not 
allow an adjacent team coach to start the Return to Normal process.

When a team is in the reconfigured state and the alternate source experiences a new 
event, the team can look for a new alternate source, if available, to supply its line segment.

A normally open switch in a source/substation location must have the voltage sensors 
on the substation side. Otherwise, transfer operations will not work correctly. If this is an 
existing installation with voltage sensors on the wrong side and they cannot be moved, 
contact S&C Electric Company for more information.

To enable automatic load transfer:
• Set the Team Logic setpoint on the Setup>Restoration>IntelliTeam SG> Team X 

screen to Enabled mode for each team if applicable.

• Use either the faceplate AUTOMATIC OPERATION ENABLED/DISABLED switch 
or a SCADA command to enable the Automatic Operation mode for the switch  
control.

A large IntelliTeam SG system may have reconfigurations occurring simultaneously at 
more than one location. To prevent circuit overloading, the system uses contracts to  
ensure that it will not pick up more line segments than the circuit can supply. Contracts 
travel across teams to safely secure resources needed to energize the line segment.

As the IntelliTeam SG system transfers load to an alternate source, a contract is  
required if the Line Segment Limit setpoint has been set or if a Line Segment Limit 
value has been propagated from the source. A contract is generally not required unless 
the line segment being energized will be directly or indirectly fed from an alternate 
source. For example, a source/substation switch never requires a contract to close, but 
a tie switch will always require a contract to close.
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Every team member has a contract agent. Unlike the coach, contract agents are 
static, and only the contract is communicated. The contract agent obtains contracts and  
maintains outstanding contracts.

A contract is required when:

• During a transfer event the coach of the requesting line segment asks a team  
member to close an alternate source switch to energize the segment

• A team member contacts the coach of the alternate-source line segment to verify  
circuit resources

• A team member finds the line-segment limit has not yet been exceeded and it  
issues a request to the local contract agent (While the contract agent works to  
obtain a contract, both the requesting coach and the alternate-source coach must  
remain at this team member (except to satisfy the Visit timer). The team member also 
waits while the contract is being obtained.)

• The contract agent prepares and sends the contract to the agent of the team  
member presently the source for the alternate-source l ine segment (The  
requesting agent waits for the contract to be returned.)

• The receiving contract agent checks the requested resource availability (When there 
is not enough excess capacity, the agent updates the contract to decline the request 
and returns the contract to its sender. When sufficient excess capacity is available at 
this team member, the contract agent adds its ID to the routing list and forwards the  
contract to the next team member in the direction of the absolute source.)

• The contract reaches the source/substation switch agent and the agent checks for 
available excess capacity (When the contract request exceeds excess capacity, 
the agent declines the contract and returns the contract directly to the originating  
contract agent.)

• Circuit resources are sufficient and the contract agent accepts the contract, lists its ID 
as the granting contract agent, increments its local count of line segments that have 
been transferred, and keeps a copy

• Following the contract routing table, the accepted contract returns, through each  
previous contract agent, back to the originating agent (When the contract is declined 
it goes directly to the originating contract agent.)

• The contract is declined and the requesting agent reports to its team member that the 
transfer is not allowed and dissolves the contract (When the contract is accepted, the 
agent reports that the transfer may continue and the agent saves the contract.)

An accepted contract must be maintained and carry an associated maintenance timer. 
The requesting contract agent or an intermediate agent can initiate contract maintenance. 
When the timer expires, the agent sends a maintenance message along the contract route 
to verify the existence of the contract and reset the maintenance timer.

The requesting contract agent may also dissolve the contract when a manual 
switching operation energizes the line segment from another source, a local Return-to- 
Normal operation occurs, or a second event occurs that causes additional circuit 
reconfiguration. To dissolve the contract, the requesting agent sends a message down 
the contract route. Each contract agent then dissolves the contract and decrements the 
local line-segment count.
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Prohibit Restoration This feature disables the team Automatic Restoration feature (automatic closing of 
switches) in case of emergency or for circuit anomalies where restoration would be  
undesirable. The feature is enabled and disabled by SCADA (with DNP Control Point 
Code #21) and also with the IntelliLink Enable/Prohibit Restoration selection on the 
Setup>Restoration>IntelliTeam SG>Team Summary screen. See Figure 3 on “Figure 3. 
The IntelliTeam SG>Team Summary screen.” on page 17. The Prohibit Restoration 
command affects all teams associated with the switch control receiving the command.

The Prohibit Restoration command will not prevent the auto-sectionalizing logic 
from acting on fault conditions to open the switch. When a team is not ready to transfer 
(such as the Prohibit Restoration state), the auto-sectionalizing logic reverts to standard 
sectionalizing logic. Standard sectionalizing logic does not include sectionalizing on 
three-phase voltage loss or on an extended three-phase voltage loss. If all automatic 
operation must be stopped, the user must  send the DNP Disable Automatic command 
(with DNP Control Point Codes 13 or 14) to each switch individually.

Indications that a team is in the Prohibit Restoration state are:

• The Setup>Restoration>IntelliTeam SG>Team Summary screen will indicate 
***Alarm*** in the Ready Status field.

• The LCD display will indicate ***Alarm*** instead of the Ready state for that team.

• The DNP Status Point Code #47 will be set.

Return to Normal Following the reconfiguration event and subsequent repair and restoration of the faulted 
line section, team members can return to their normal state. When the Return-to-
Normal timers expire, the coaches begin the process of returning each team to its normal  
configuration. The Return-to-Normal process begins at the team closest to the normal 
source and works outward. The closed transition Return-to-Normal mode must notify 
the normal tie switch before it continues.

Each team member may be configured for an open or closed transition. Teams with 
no tie switches allow their members to follow the needs of the adjacent teams.

A load switch between teams where an open transition is required will remain closed. 
It relays the Return-to-Normal request, becomes de-energized, and returns a go-ahead  
message before finally being reenergized from the normal source.

The team member at a tie switch will automatically open the switch after a prescribed 
timeout. This ensures a circuit parallel condition will not be left in place indefinitely.

To enable Return to Normal:
• Set the Rtn to Norm Mode setpoints on the Setup>Restoration>IntelliTeam SG> 

Team X screen to the Open or Closed state for each team member in each team,  
if applicable.

• Use either the faceplate AUTOMATIC OPERATION ENABLED/DISABLED switch or 
a SCADA command to enable the Automatic Operation mode.
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Figure 3. The IntelliTeam SG>Team Summary screen.

Prohibit Restoration
The IntelliTeam SG Restoration feature can be enabled or disabled on the  
IntelliTeam SG>Team Summary screen. See Figure 3.

When the Prohibit Restoration mode is active, view the Logs>Status Point Log 
screen to determine whether this was the result of a SCADA command or a Prohibit 
Restoration Timer operation.

The Prohibit Restoration mode also may be enabled automatically through use of 
the Prohibit Restoration timer configured on the Setup>Restoration>IntelliTeam 
SG>Team X screen. Enabling this feature automatically with the timer is useful when 
needing a predetermined time limit for the team to perform restoration. If restoration 
does not occur within this time limit, all restoration activity will be stopped and the 
team will remain in an alarm state until the Prohibit Restoration feature is disabled.
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The Report feature will save the control software settings and stored data to the  
computer in a CSV (comma-separated value) file. A report can be saved as a permanent 
record, and report data can be used in spreadsheets or other programs.

Follow these steps to generate reports:

STEP  1.  Connect the computer to the switch control and start the IntelliLink software.

STEP  2.  From the Data menu, choose the Reports option. 

STEP  3.  Select the report and click on the OK button.

STEP  4.  In the Save Report dialog box, specify a name and location for the report and 
click on the Save button.

When a location is not specified, the file is saved to the same directory as the 
program files for this team member (the default location is C:\Program Files\ 
S&C Electric\). The extension “.CSV” is added automatically. When the report is  
complete, the message ***Task completed*** appears on the status line of 
the Writing Report dialog box.

STEP  5.  Click on the OK button. The software closes the dialog box.
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Saving a Setup 
Configuration

When two or more team members use a similar setup configuration and the same software 
version, users can save the configuration from one team member and load it into the 
other(s). Only the setpoints unique for each individual team member must be manually 
adjusted.

This process also can be used to save the setpoint values on the Setup>Restoration> 
IntelliTeam SG>TeamX screen and then load these setpoints into each team member. 
This ensures the Setup>Restoration>IntelliTeam SG>TeamX screen is identical for all 
members of the same team. Follow these steps to save the setpoint values:

STEP  1.  Select the team member that contains the configuration being saved.

STEP  2.  Connect the computer to the selected team member and start the IntelliLink  
software.

For information about starting the IntelliLink  software, see the Start 
IntelliLink Software section in S&C Instruction Sheet 1043-531, “IntelliNode™ 
Interface Module: Setup.” If the computer is already connected to the team 
member, skip this step. 

STEP  3.  In the screen menu select the File step-down menu and click on Save Setpoints 
entry.

STEP  4.  In the Select Setpoint Profile dialog box, choose the setpoint values to save.

(a) To save the stand-alone setpoint values, click on the PROFILE: Non-Team 
Setpoints option, and click on the OK button.

(b) To save the team setpoint values, click on the PROFILE: Team X Setpoints 
option for the desired team, and click on the OK button.

(c) To save all setpoint values, including values for teams that may not have 
been configured, click on the Save Configuration Data option, and click 
on the OK button.

STEP  5.  In the Save Setpoints dialog box, specify a name and location for this  
configuration (CFG) file, then click on the Save button and click on the  
OK button.

Be sure to name team setpoint profiles logically. For example, use the Team 2 name for 
the Team 2 setpoints. When loading the setpoint profile into another team member, the  
Intel l iL ink software wil l automatica l ly place the prof i le into the Setup> 
Restoration>IntelliTeam SG>TeamX screen with the matching team number.

If a location is not specified, the file is saved to the same directory as the  
program files for this team member. The default location is C:\Program Files\S&C Electric\. 
The extension “.CFG” is added automatically.

For the stand-alone setpoints, this process does not save the physical location, the  
Local Device DNP Address setting (on the Setup>Communications>DNP screen), or 
the sensor-configuration data (on the Setup>General>Sensor Cfg screen), if applicable.

S&C Instruction Sheet 1043-541  19

Saving and Loading a Configuration



Loading a Setup 
Configuration

When two or more team members use a similar setup configuration and the same software  
version, the configuration can be saved from one team member and loaded into the other(s). 
Only the setpoints unique for each individual team member must be manually adjusted.

Follow these steps to load a setup configuration:

STEP  1.  Connect the computer to the team member whose configuration is being saved 
into and start the IntelliLink software.

For information about starting IntelliLink software, see the “Start IntelliLink 
Software” section in S&C Instruction Sheet 1043-531, “IntelliNode™ Interface 
Module: Setup.” If the computer is already connected to the team member, 
skip this step.

STEP  2.  In the screen menu select the File drop-down menu and click on the Load 
Setpoints option.

STEP  3.  In the dialog box, select the CFG file for the configuration being loaded and click 
on the Open button.

STEP  4.  Make any setpoint changes that are required for this team member. For more 
information see Instruction Sheet 1045-530, “S&C  6800 Series Automatic 
Switch Controls: Setup.”

Note: If loading the stand-alone setpoints, be sure to enter the correct value for 
the Physical Location setting, the Local Device DNP Address setting (on the 
Setup>Communications>DNP screen), or the sensor configuration data (on the 
Setup>General>Sensor  Cfg screen), if applicable.
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Viewing IntelliLink 
Screens Without a 
Connection

Saving Settings and 
Data to a Snapshot

To view the IntelliLink screens and Help file without connecting to a team member or a 
snapshot:

STEP  1.  Start the IntelliLink software on the computer. During startup, click on the 
Cancel button to close the Connect dialog box.

When the IntelliLink software is already running, choose the Disconnect 
from the Connection option, then in the File pull-down menu choose the 
Close Screenset option to clear the present screenset from memory.

STEP  2.  From the File pull-down menu, choose the Open Screenset option.

STEP  3.  In the Open Screenset dialog box, find and select the .WMN file whose name 
matches the software version name for this switch control.

 
Follow these steps to save operational and data-logging information in Snapshots (.VM, 
virtual memory files). Snapshots let users view data, generate a report, and save or change 
setpoint configurations even when not connected to a switch control. To access the stored 
information, connect to the snapshot instead of the physical control. 

STEP  1.  Connect the computer to the switch control from which information is to be 
saved, and start the IntelliLink software.

For information about starting IntelliLink software, see the “Start  
IntelliLink Software” section in S&C Instruction Sheet 1043-531, “IntelliNode™ 
Interface Module: Setup.” If the computer is already connected to the team 
member, skip this step.

STEP  2.  From the File pull-down menu, choose the Save Snapshot option.

STEP  3.  In the dialog box, specify a file name and location for this snapshot. Then, click 
on the Save button.

If a location is not specified, the file is saved to the same directory as the program 
files for this team member (the default location is C:\Program Files\S&C Electric\). The 
extension “.VM” is added automatically.

Follow these steps to open the snapshot with the IntelliLink Offline software:

STEP  1.  Start the IntelliLink software on the computer. During startup, click on the 
Cancel button to close the Connect dialog box.

STEP  2.  When the IntelliLink software is already running, choose the Connection 
option and click on the Disconnect option. If wanting to view a snapshot for a 
different type of control, select the File pull-down menu and click on the Close 
Screenset option to clear the present screenset from memory.

STEP  3.  From the File pull-down menu, click on the Open Snapshot option. The Open  
Controller Data File dialog box opens. Select the snapshot to view. Then, click 
on the Open button.

STEP  4.  To change the configuration settings in the snapshot in the Connect to File 
dialog box, click on the Yes button. To avoid accidentally changing a setting, 
click on the No button. The IntelliLink software opens and displays the  
contents of the selected snapshot.

Viewing a Snapshot
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All changes made to configuration settings in the snapshot are automatically saved to 
disk immediately. It is not necessary to save the changes in a separate operation.

Follow the same procedure as when connected to a switch control.

This procedure allows users to prepare a setpoint configuration for a team member in the 
field and there is no access to a comparable device. Follow these steps:

STEP  1.  Connect to the snapshot.

STEP  2.  Change the configuration settings in the snapshot as needed.

STEP  3.  To save a configuration, follow the same procedure as when connected to the 
control. 

For stand-alone setpoint values, this process does not save the Physical Location or 
the Local Device DNP Address setting (on the Setup>Communications>DNP screen), 
if applicable.

Saving Changes Made 
to the Snapshot

Generating a Report 
from a Snapshot

Creating a 
Configuration File 
from a Snapshot
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